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CHAPTER 1
Introduction

C orporate valuation modeling consistently proves challenging because it requires
a thorough understanding of two bodies of thought that demand disparate skill

sets: finance and technology. On the finance side, we must understand fundamental
topics such as time value of money, growth rates, debt calculations, and other subjects
that blend accounting, economics, and mathematics. In particular, accounting is a
subject that corporate valuation analysts must be well versed in because generally
accepted accounting principles (GAAP) or international financial reporting standards
(IFRS) need to be followed to make sure analyses are consistent. On the technology
side, we must select a program or programming language to utilize and understand
the technical functionality of that program well. In many cases, the program is Excel,
which requires knowledge of a number of program-specific functions and techniques
in order to transfer the financial concepts to an orderly, dynamic analysis. Prior to
jumping right to the construction process, we will take a step back and examine the
overall process.

OVERVIEW OF THE CORPORATE VALUATION PROCESS

The corporate valuation analysis process itself is quite complex with many moving
parts that are intricate to stitch together. Taking a reverse approach, that is, starting
with the firm value and tracing back its calculations and components, is a good
method of gaining an overview of this process.

Projecting Cash Flow

Figure 1.1 provides a graphical overview of the discounted cash flow valuation
process. First, we should establish that we will take a discounted cash flow approach
to determining corporate value. Many other methods exist, such as relative valuation
and adjusted present value, but the most popular detailed analysis is to discount
expected future cash flows.

Discounting expected cash flows is a method used in many areas of finance.
Bond pricing, securities analysis, and project valuation all use discounted cash flow
techniques. Any discounted cash flow technique has two general components: future

1

CO
PYRIG

HTED
 M

ATERIA
L



c01 JWBT203-Allman December 4, 2009 18:58 Printer: Malloy

2 CORPORATE VALUATION MODELING

F IGURE 1.1 Overview of the corporate valuation process.

expected cash flows and a rate or rates to discount those cash flows to bring them to
the present value. The sum of all present-valued cash flows is the value. So the path
we first go down is making sure we do the best possible job of estimating future cash
flow and calculating discount rates.

Starting with the future cash flows, we have to think about what constitutes cash
flow. Is it gross profit, or net income, or earnings before interest and taxes (EBIT)?
While those are standard metrics for cash flow, they do not wholly represent cash
that can be freely distributed to parties of the firm. We must be able to distinguish
between real cash and non-cash items that flow through financial statements and
ensure that the company can meet its capital expenditure requirements and fund
working capital needs.

Each of the items that lead us to our cash flow can be broken apart into detail.
Specific capital expenditures or debt financing plans can be modeled. For instance, we
may anticipate debt financing and be the lead bank in a syndicated funding or be part
of a bilateral arrangement. In such cases we may be concerned with the priority of
cash flows. This level of detail can lead us to more accurate projections of cash flow.

The next challenge with cash flow is the duration of cash flow projection. In
discounted cash flow modeling, we typically distinguish between a forecast period
valuation and a terminal valuation. This means that we forecast specific cash flows
only for a certain amount of time depending on the purpose of our valuation.
Continuing with the debt example, if we plan to issue five-year debt, we may project
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FIGURE 1.2 The forecast period is typically in alignment with a unique
period of time for the company. This can be due to a startup period,
distress, buyout, new funding, or new projects. The terminal value is the
assessment of value after the forecast period.

out five years of a company’s cash flow. If we ignore time beyond the five periods,
then we make the assumption that the firm is worth nothing after that time period;
it essentially vanishes. This is unlikely, because at bare minimum a firm has assets
that can be disposed of and the proceeds returned to debt and equity holders. It is
even more likely that the firm would continue operations.

Whether we assume the firm is liquidated after the forecast period or that it
continues into perpetuity, we need to do more work to make a terminal value
assumption. This could require altering assumptions to a long-term perspective
and in general applying a different methodology than just cash flow forecasting.
Figure 1.2 depicts forecast and terminal value periods.

Discounting Cash Flow

Once we are confident in our cash flow and terminal value, we must determine the
proper discount rates to apply to the values in order to get the present-day valuation.
If we are looking at the firm from a comprehensive viewpoint, we need to examine
what both an equity holder and a debt holder would demand for the firm’s risk,
respectively known as the cost of equity and the cost of debt. Picking apart those
calculations leads us to further detail.

The cost of equity can be determined using the capital asset pricing model
(CAPM), which quantifies the rate of return for an equity investor based on a risk-
free return, a market-based return, and a quantification of nondiversifiable risk.
These factors materialize in the form of the risk-free rate, the market risk premium,
and beta. Multiplying beta by the market risk premium and then adding the risk-free
rate gets us to the cost of equity for one period. Although this is a good start, we
may have different assumptions throughout time for each of these items.
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The cost of debt also contributes to our eventual discount rate for the cash flows.
The credit quality of the firm and current market conditions determine the spread
over the risk-free rate that the company must pay for its debt. Because interest is tax
deductible in most cases, the firm’s after-tax cost of debt is more relevant, meaning
we need to also estimate the tax rate to get an accurate assumption.

Overall, both rates may change over the forecast period and can have completely
different assumptions for the terminal value period. Further complicating matters is
that we do not take a simple average of the two values, but weight each rate by the
amounts of debt and equity. Whereas in theory these should be market values, book
values are sometimes used as proxies in projections. In cases of expected capital
structure changes, the weights can change over time and significantly affect the
discount rates, which ultimately affect the valuation.

CONCEPTUAL ROADMAP

Our heads may be spinning in a whirlwind of financial concepts right now. The
immediate way to bring order to this chaos is to open our medium of operation,
Excel, and start entering information. But without a carefully laid-out plan, this
can be disastrous. To prevent such disaster, we will lay out a conceptual roadmap
that will guide the corporate valuation process and its materialization in Excel. This
conceptual roadmap is shown in Figure 1.3.

The first destination on this map is dates and timing, which provide the frame-
work for our analysis. Once we know what timeframes we are working with, we
need to fill in the required information for each period. Because dates and timing is
the first concept, it does bring along with it some administrative qualities, such as
setting up our assumptions in an intelligible manner and creating an auxiliary sheet
to handle administrative items.

F IGURE 1.3 Building a corporate valuation model should be done using a conceptual approach.
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We can then move to the next few locations on our map, which are the financial
statements. It’s usually easiest to begin with the income statement. On that statement
our biggest concern is most likely revenue growth, because many assumptions are
predicated on this projection. We should therefore focus on understanding growth
projection methodologies. Inextricably linked to the income statement is the balance
sheet. Capital expenditures, depreciation, and debt are key items to the balance
sheet, which require further analysis. Once both statements are established, we need
to understand their linkages and create functionality that allows the sheets to work
harmoniously in projections.

After building in the key calculations of cash flow, we need to make sure that
we did so in a precise manner and in a way that is representative of the firm’s value.
The cash flow statement is established to reconcile cash and validate the model’s
calculations. Other tests are also built in to focus on important parts of corporate
cash flow. Eventually we need to summarize this cash flow in a way that represents
the value of the firm, otherwise known as free cash flow. The free cash flow is
calculated for each period of the forecast period, a terminal value determined, and
all values discounted back to the present value at appropriate discount rates.

While our core valuation ends there, we might want to analyze the system we
have set up in more detail and build in efficiencies for working with our analysis.
An output summary can reorganize information in formats that people are used to,
charts can be created to graphically represent data, and automation can be built to
allow sensitivity analyses en masse.

TECHNICAL ROADMAP

While the concepts behind corporate valuation may start to make sense, actually
transforming these concepts into a model adds the final layer of challenge. De-
pending on one’s background, utilizing Excel for the transformation of corporate
valuation concepts to a corporate valuation model is much more challenging than
understanding the concepts themselves. Quite frequently people suffer from what I
have termed sheet 1 syndrome. This condition occurs when someone is intimidated
by the vastness of the financial modeling process and stares at the first sheet of a
new, blank Excel workbook, wasting time and fretting about what to do first. We
will quickly develop a technical roadmap to prevent such an unpleasant condition.
Overall, our technical progress should take the following steps in order:

1. Brainstorm and sketch
2. Data collection
3. Assumption verification and aggregation
4. Structural construction
5. Internal validation
6. Output reporting
7. Interpretation
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Brainstorm and Sketch

While this seems as if we are going back to elementary school, it is worth taking
30 minutes to an hour to think about the problem that requires modeling. You
should employ techniques that are optimized for how you work through problems.
For example, I am a very visual problem solver and like to draw out each sheet as a
box, connect lines to boxes that represent links in the future Excel model, and write
out notes that indicate special functionality that might be required. I once started
a model while at a job late at night without taking this step. On the second day of
working through the model, I realized I had forgotten a core component and then
spent an entire half-day linking up the inserted component. I wasted hours verifying
that the links were correct, and probably would not have had to do so if I had
inserted the concept in a logical order.

Data Collection

In this book, all of the necessary data is provided, which is unrealistic in our day-to-
day jobs. Most financial analysts spend a significant amount of time searching for
the best data to use for their analyses. This is done by searching through financial
statements, industry reports, consultant studies, and market databases, and engaging
in ongoing client communication.

Assumption Verification and Aggregation

Once our data has been collected it is rarely in a format that is ready for use. Financial
data may be in values that we do not want to use for our analysis. For instance,
we most likely would want a revenue growth rate assumption for our company.
We could look historically at revenue amounts and then try different methods of
calculating the growth rate. Once we settle on a growth rate methodology, we might
want to verify that this is in line with management’s plans or that there are non-
historical factors that might affect the assumption. We should be rigorous in our
approach and do this for as many assumptions, in as much detail, as possible.

Structural Construction

Constructing the framework for calculation is the focus of much of this book. We will
definitely cover topics such as assumption verification and aggregation, outputs, and
so on, but the core problem people have is binding all of this together in a cohesive
model. I believe that the structure of the model is the easy part of the analysis process,
once it is understood. After you gain fluidity in the model construction process, the
actual framework for the model should occupy about 20% of your time. Determining
what goes into the model and understanding the correct analyses to make should
occupy the remaining 80%.
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Internal Validation

Unfortunately, many people are so anxious to get a result that the moment they come
up with a figure they stop. There are many more steps to a proper modeling analysis.
As a model is being built it should be constantly tested for validity. Concepts such
as assets equaling liabilities plus shareholder’s equity or cash from the cash flow
statement equaling the cash from the balance sheet should be tested.

Output Reporting

In my first position in a quantitative analytics group there came a time when I finally
was responsible for my own analysis. When I turned the analysis in, I handed over
nearly a hundred pages of cash flow scenarios with a summary sheet on top. My
manager took the packet of information, ripped off the summary sheet, and threw
the rest in the trash bin. The point of explaining this is that you should understand
what data your audience wants. In that case, I was presenting results to a manager
who wanted only a top-level understanding of the data. If I had presented the data to
a risk manager or another quantitative analyst, they might have wanted the cash flow
scenarios. The best models and modelers can get overlooked due purely to output
presentation (sad, but true in the field of finance).

Interpretation

Finally, you must understand the model that you have built. Especially if you must
present the analysis to others, you must be well versed in the resulting changes in
the model given changes in the assumptions. This means that you should test the
model with reasonable extremes. Take growth down to 0% in one scenario. What
happens to the firm’s value? Then take growth up to 100% each period. Does the
firm’s value increase? Try out many combinations of assumptions, such as increasing
capital expenditures and adding a debt layer to pay for it. Can the company afford
the expected debt payments each period? Similar to output reporting, people lose
faith in a model that returns unexplainable results.

A FEW BEST PRACTICES REGARDING FINANCIAL MODEL ING

Over the years of financial modeling development, I have discovered a number of
best practices. Conforming to the following allows other users easier interpretation
and prevents errors:

1. Use consistent formulas for rows or columns. Whether it is to be dragged across
columns or up and down rows, the formula should be the same. Differences
usually occur during certain time periods, which suggests the need for functions
that give our formulas optionality.
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2. Never combine a hard-coded assumption with a formula. If you find yourself
inserting numbers into a formula, you should consider making that number a
formal assumption in the appropriate section.

3. Hard-coded values should be formatted using blue bold font. Formulas are
typically kept in black-colored font. The origins of these formatting conventions
are unclear, but they are market practice and allow users to quickly identify
assumptions and formulas.

4. Corporate models frequently organize time going across columns, whereas asset-
based and project finance models occasionally organize time going up and down
rows. This convention is due to the 256-column constraint of Excel 2003 and
earlier. Although Excel 2007 has plenty of columns, I have found that many
financial modelers still adhere to these conventions.

HOW THIS BOOK WORKS

This book is designed in a manner similar to the corporate valuation courses I teach
in person. Both rely on theory and practical exercises to transform the concepts
into a dynamic, usable model. Just as my courses work through individual mod-
ules of corporate valuation that culminate in a complete firm valuation, this book
has readers work through similar modules, chapter after chapter. Each section begins
with a discussion of theory and then moves on to a Model Builder exercise where the
theory is transferred to an application in Excel. Eventually, as all theory concepts are
read and Model Builder exercises completed, the reader should have an operational
model that is identical to the one included on the CD-ROM that is packaged with
this book.

While theory and implementation are two critical elements, one of the biggest
challenges of teaching financial modeling is the different skill levels of readers. In my
classes, I am able to teach to various levels of difficulty and explain functionality as
needed. In print, this is clearly not possible, but I have tried to address the issue of
varying skill levels by creating sections at the end of each chapter called toolboxes.
These sections explain Excel functions and techniques that are used throughout
the chapter. Readers who are beginners will find it valuable to go through every
Toolbox. Intermediate readers can selectively choose which Toolbox sections to
read, and advanced readers can skip them altogether. Figure 1.4 depicts the book’s
approach.

Excel 2003 and Earlier versus Excel 2007

At the current time, many users have switched to Excel 2007; but many, if not more,
are still using Excel 2003. While the powerful differences between the two versions
of Excel are related to memory accessibility and usage, there are major shifts in
the menus. When technical books provide instruction for only one version, and the
user has a different version, the alterations to the menus can cause confusion. For
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FIGURE 1.4 Each chapter will follow a similar pattern,
starting with corporate valuation theory, then model
implementation, followed by a Toolbox to assist with Excel
functions and techniques.

this reason, I will provide instruction for both versions of Excel wherever there are
instructions that could be significantly different between the two versions.

Differences between Excel versions will not be an issue when this book discusses
Visual Basic Applications (VBA) in Chapter 11, since the Visual Basic Editor (VBE)
and the VBA code have largely gone unchanged. The only caveat is that users who are
using Excel 1997 or earlier may encounter problems since there were many updates
to VBA after that version.

A Few Words about Semantics

Learning about financial modeling can be tricky in written form since words translate
into commands, which can be very specific for computer programs. In this text we
are using Excel as the modeling program, which is primarily operated by menus,
worksheets, and cells within the worksheets. For the menus in Excel 2003, I will
often use the word select, which would be synonymous with left-clicking the stated
menu. There could be multiple options, where once you left-click you might have
to move the cursor down and over to find the correct sub-selection. For instance,
if you wanted to open the Add-Ins dialogue box you would have to select Tools,
then move the cursor down to Add-Ins and select or left-click again. The process
is slightly different for Excel 2007, where there is a ribbon system. In the ribbon
system you still must select or left-click on a tab, but instead of having a drop-down
of sub-selections there are graphical icons that must be selected. These graphical
icons are grouped into subsets, such as the Font subset, within the Home tab.
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The process of using workbooks and cells is relatively similar between Excel 2003
and Excel 2007. The key is that there are four main operations we will perform on
a cell:

1. Enter a value. When the Model Builder exercises ask for a value to be entered,
this will be a number, date, or Boolean (TRUE or FALSE) value. These are values
that will be referenced for some type of calculation purpose.

2. Enter a label. A label is text in a cell to help the model operator understand val-
ues and formulas in relative proximity. Note that I use the word as a verb
as well. For example, I may say “label cell A1, Project Basic Cash Flow.”
This means that the text “Project Basic Cash Flow” should be entered into
cell A1.

3. Name a cell or range of cells. Not to be confused with labeling, naming is a
specific technique that converts the reference of a cell or range to a user-defined
name. This process is detailed in the Toolbox section of this chapter.

4. Enter a formula. The core reason we are using Excel is for calculation pur-
poses. A formula is initiated in Excel with the “=” sign. When I say to enter
a formula, I will provide the cell it should be entered in and the exact formula
that should be entered. Often I have copied this formula from the Excel model
itself to ensure that the text corresponds to the example model provided on
the CD-ROM.

MODEL BUILDER 1.1: IN IT IAL SETTINGS AND ASSUMPTIONS
SHEET SETUP

In our first Model Builder, we should take a moment to understand how this section
differs from other parts of the book. Each Model Builder is an instructional section
that should be completed with the use of a computer running Excel. It should be
followed step-by-step using the instructions. Each Model Builder assumes that the
previous Model Builder was read and implemented. The eventual result of the Model
Builder sections is the Corporate Basic.xls model provided on the CD-ROM. If at
any point you find yourself lost, you should open the Corporate Basic.xls file to see
how the relevant section should be completed.

This first Model Builder is to make sure that our versions of Excel are all set
to identical settings and to start constructing the model on the Assumptions sheet.
Depending on how you installed Microsoft Excel or Office, you might need the
installation disc to enable all of these settings.

1. We will be using a few functions and tools that require the Analysis Tool Pak,
Analysis Tool Pak VBA, and Solver Add-Ins to be installed. To do this:
� For Excel 2007: Select the Office button, select Excel Options, select Add-Ins,

and then select the Go button, which is to the right of Manage, and a box
that should default to Excel Add-Ins. This will bring up the same box as in
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FIGURE 1.5 The Add-In selection box allows users to
install pre-created or user-created add-ins.

Figure 1.5. Check the boxes for Analysis Tool Pak, Analysis Tool Pak VBA,
and Solver. Select OK. If the Add-Ins are not installed, it may prompt you
with a few messages stating that Excel will need to install them. Depending
on how Excel was initially installed, you might need the installation disc to
complete the install.

� For Excel 2003 and earlier: Select Tools, select Add-Ins, and check the boxes
for Analysis Tool Pak, Analysis Tool Pak VBA, and Solver. Typically the
Analysis Tool Pak and the Analysis Tool Pak VBA are the first two Add-Ins
on the Add-Ins list. Solver is usually at the bottom. Select OK. If the Add-Ins
are not installed, it may prompt you with a few messages stating that Excel
will need to install them. Depending on how Excel was initially installed, you
might need the installation disc to complete the install. Figure 1.5 depicts the
Add-In selection box.

2. The next setting we should set is the ability to run macros. While the core
model does not require the use of any macros, Chapter 11 will add significant
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automation and functionality through the use of VBA. If you would like to take
advantage of this, you will need to complete the following steps.
� For Excel 2007: Excel 2007 requires a bit more setup to work with macros.

Select the Office button, and select Excel Options. On the default tab, the
Popular tab, check the third checkbox down, entitled “Show the Developer
tab in the Ribbon.” Press OK. Once the Developer tab is visible, select it and
then select Macro Security. In Excel 2007, you have four options for Macro
settings, three of which are similar to Excel 2003. The only exception is that
you can disable all macros except ones with a digital signature. Since hardly
anyone has taken Microsoft up on their security measures and people rarely
use digital signatures for Excel files, we will ignore that option. We can safely
set it to disable all macros with notification. The notification will occur when
the workbook is opened and will be a button with Options . . . in it at the
top of the sheet. Select this button. A new dialogue box will open. Within
that dialogue box, under Macros and Active-X, select Enable This Content
and press OK. This dialogue box is shown in Figure 1.6. In Excel 2007, you
should not have to restart Excel for this to take effect.

� For Excel 2003 or earlier: Select Tools, select Macros, select Security. You
have the choice of either Low, Medium, or High. Low will allow macros

F IGURE 1.6 Once the macro security setting is set to Disable All Macros with Notification, the
following Options . . . button appears when workbooks with macros are opened.
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without prompting, medium will prompt you to enable or disable macros
within a workbook when it is opened, and high disables macros in a work-
book. The main concern is that viruses can be built into macros, which can
cause significant damage or security concerns. The Corporate Basic.xls model
contains no viruses and can be safely opened with macros enabled. You might
want to set your computer to medium security so that you enable only trusted
workbooks. For the changes to take effect you must shut down Excel and
reopen it. When prompted to enable macros for the Corporate Basic.xls file,
select Enable.

3. Once the Add-Ins are installed and the macro security is set, we can actually
start constructing our model. The next step is to notice the default setting of
the worksheets. There should be three blank sheets named Sheet1, Sheet2, and
Sheet3. Change the name of Sheet1 to Assumptions.

4. Next we will create a label for the entire project. On the Assumptions sheet in
cell A1, enter the text Project Basic Cash Flow. Format this text bold blue. The
reasoning behind the formatting is grounded in a financial modeling convention,
where all variables that are inputs entered as values (otherwise known as hard
coded) are formatted bold blue. Values returned from formulas are typically left
in standard black-font format.

5. Name cell A1 inputs ProjName. Naming cells is distinctly different from entering
text as the previous step instructed. For basics on naming cells, refer to the
Toolbox section of this chapter for a thorough primer on naming cells and
ranges. Cell A1 should look like Figure 1.7.

6. The final step of this brief Model Builder is to save the file—a simple yet com-
monly forgotten step. As a suggestion, you might want to just add your initials
to the end of Corporate Basic.xls (Corporate Basic KA.xls, in my case). Most
Excel 2003 or earlier users are familiar with the steps to saving, but Excel 2007
users should be careful as there are many new options. In Excel 2007, under
Save As, if you select Excel Workbook it will save it as the default file for Excel.
This is usually set to a macro-free .xlsx file. This means that if you created any
code in the file, it will automatically be stripped out and lost. If you want to save
a workbook with code (which will be the case if you implement the VBA for
the Corporate Basic model), then you should save it as an Excel Macro-Enabled

F IGURE 1.7 In cell A1, on the Assumptions sheet, we create a label
for the cell by entering text. Notice the cell is also named, as seen by
the name inputs ProjName in the Name Box.
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Workbook. Both of these formats are .xlsx and are not compatible with earlier
versions of Excel unless the user downloads a special file from Microsoft. If
you or another user anticipate using this file with lower versions of Excel, you
should save the file as an Excel 97–2003 Workbook. This format is .xls and will
not automatically remove macros. The possible file formats for Excel 2007 are
shown in Figure 1.8.

F IGURE 1.8 Be careful when saving files in Excel 2007 as there are many
more options.
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TOOLBOX: NAMING CELLS

A very common technique used throughout financial modeling is to name a cell or
range of cells. To name a cell or a range of cells is to provide an alternative name
other than the standard row/column name, such as cell A1. Naming cells has a
number of advantages:

1. Named cells are easier to work with in formulas since we can name them with
meaning. For instance, rather than using the range B3 to refer to the current
fiscal year date of a model, we could name cell B3 FY Current. When working
with formulas, the name would be used rather than B3, and the formula would
be easier to understand.

2. Named cells automatically take on absolute references in formulas. When cells
are referenced in formulas, their default setting is set to relative references.
This means that if we referenced cell B3 in a formula and dragged the formula
cell across one column, the new formula would reference cell C3. This can be
prevented by locking down the cell, as described in Chapter 5’s Toolbox, or by
using a name. A named range is automatically locked down. We can still use the
row/column reference, but would have to enter this in by hand since named cells
will automatically display the name when referenced.

3. Named cells allow us to reference values for data validation lists on sheets other
than the sheet where the list is being created. If this is not clear, you should read
about data validation lists in Chapter 2’s Toolbox section.

4. Named cells allow the user to find inputs and references faster. When we push
cell F5, we are provided with the Go To dialogue box. This allows us to jump
to sections in a model very quickly. When we use named ranges, we can move
between them very quickly.

5. Named cells make in-and-out processes easier when we start using Visual Ba-
sic Applications (VBA). We will come back to this in Chapter 11 when we
implement basic VBA code.

Cells can be named very quickly using the Name Box in both Excel 2003 and
2007. The Name Box is located near the upper-left corner of any Excel sheet.
Figure 1.9 shows the location of this box.

F IGURE 1.9 The Name Box is an area that
allows a user to quickly create a name for a
cell or range of cells.
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There are a couple of rules regarding naming:

1. Names cannot have spaces. If you want to use a name with spaces, use under-
scores. For instance, if you wanted a cell that was named Reserve Account, you
would have to name it Reserve Account.

2. In Excel 2003 and earlier, names cannot begin with a number. Excel 2007 will
allow this; however, when the spreadsheet is saved in Excel 2003 or earlier,
a prompt will be generated that informs a user that the names will have the
number values removed. This can cause problems if the numbers were the only
differentiation between names in the workbook.

Finally, the most common source of error in naming is when the names need to
be changed or deleted. Many users try to change names by selecting the cell or cells
that are named and typing over the name in the Name Box. While this will generate
a new name, it will not get rid of the existing name. The same is true when a user
selects a named range, highlights the name in the Name Box, and presses delete. In
Excel 2003, names should be deleted or references edited under the Insert menu,
Names submenu, Define option. This selection brings up the Name dialogue box,
which allows a user to delete or edit the name reference. In Excel 2007, users can
go to the Formulas tab and select the Name Manager button. This selection brings
up a similar dialogue box as Excel 2003’s Name dialogue box; however, there is
additional functionality. In particular, users can edit the name of a range directly
through this dialogue box.


